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What is 2FA?  
2FA is a verification process that requires users to specifically use at least two pieces of 

verification information, e.g., a password and a PIN.  

Passwords can be compromised so 2FA immediately increases account security by requiring 

more than one form of verification to prove your identity when signing into a website or an 

application.  

 

Microsoft Authenticator App  
The Microsoft Authenticator phone app gives you easy, secure access to online accounts, 

providing two-factor authentication for an extra layer of security. This Microsoft Authenticator 

phone app generates a six-digit code which users will be required to provide during the sign 

in process.  

The app icon is a blue box with a white padlock and is available in the App store on your mobile 

phone.  

 

 
Only the Microsoft Authenticator phone app is supported for use with https://sara.cso.ie 

 

 

 

Setting Up 2FA  
1. On your Home Device Browser, go to the https://sara.cso.ie 

mailto:rcu@cso.ie
https://sara.cso.ie/
https://sara.cso.ie/
https://www.microsoft.com/en-ie/security/mobile-authenticator-app
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2. Enter your RMF Researcher username with the suffix “@cso.ie” e.g., 

bloggsj_rmf@cso.ie, then click Next.  

 

 
 

 

3. Enter the password provided to you by the Researcher Coordination Unit (RCU) via 

SMS. 

 
 

4. Click Next.  

  
5. Click Set up.  
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6. The Configure mobile app window will appear on your screen. Leave this window open 

and continue with the next steps on your mobile phone.  

 

 
 

7. Go to the Google Playstore (Android) or iOS App Store (iOS) and download the 

Microsoft Authenticator phone app. Once installed, open the Microsoft Authenticator 

phone app.  

 

Please note:  

Only the Microsoft Authenticator phone app is supported for use with https://sara.cso.ie  

 

 

8. If this is the first time you are setting up the Microsoft Authenticator phone app on 

your mobile phone, proceed directly to Step 9. If you have used the Microsoft 

Authenticator phone app before on your mobile phone, proceed directly to Step 12.  

 

 

 

9. Open the Microsoft Authenticator phone app, then click Scan QR Code.  
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(Android)    (iOS) 

 

 

10. You will receive a Data Privacy prompt, click OK.  

 

(Android)  (iOS) 

 

 

 

 

 

 

 

 

 

11. On Android = Allow Authenticator to take pictures and record video, click Allow.  
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(Android)  (iOS) 

   

On iOS = Authenticator Would Like to Access the Camera, click OK, then click Add 

Account.  

Now proceed directly to Step 15.  

 

 

12. Continuing from Step 9, open the Microsoft Authenticator phone app.  

• On Android = click the 3 dots icon in the upper right corner, then click Add 

Account.  

• On iOS = click the plus icon in the upper right corner.  

(Android)  (iOS) 

13. Click Work or school account.  
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(Android)  (iOS) 

 

 

 

 

 

14. Point your mobile phone at the Configure mobile app screen currently open on your 

home device to scan the QR code.  

 

(Android) (iOS) 

 

15. You will now see your account has been added to the Microsoft Authenticator phone 

app on your mobile phone.  
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(Android)  (iOS) 

 

 

 

 

16.  Click on your new account within the Microsoft Authenticator phone app. This 

Microsoft Authenticator phone app will now display a six-digit code. This code 

changes every 30 seconds.  

 

 
 

 

 

17. Back on your home device, on the Configure mobile app screen, click Next.  
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18. Click Next.  

 
19. Enter the six-digit code that is currently showing on your mobile phone into the 

Additional security verification screen on your home device, then click Verify.  

 

 
20. If prompted, enter a back-up mobile phone number in case you lose access to the 

Microsoft Authentication phone app and click Next. Click Done.  

 
For more information on how to install the Microsoft Authenticator App and set-up 2FA, please 

see https://youtu.be/Q8OzabuNwHI 11  

 

mailto:rcu@cso.ie
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Sign in to CSO with 2FA  
1. Now that you have successfully set-up 2FA, you will be required to use it each time you 

sign into CSO. On your home device browser, go to https://sara.cso.ie  

 

2. Enter your CSO Email Address as your username e.g. joe.bloggs@cso.ie, then click 

Next.  

 
 

 

 

3. Enter your CSO password, then click Sign In. Your CSO password will have been sent 

to you via SMS. If you have not received it, please check with your RMF Contact that 

they have the correct Irish mobile number on your record in the Researchers Online 

System for Applications (ROSA).   
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4. Open the Microsoft Authenticator phone app on your mobile phone. Click on your CSO 

account to display the six-digit code. Enter the six-digit code currently displayed in the 

Microsoft Authenticator phone app into the Enter Code box on your home device 

screen, then click Verify.  

 

 

5. If prompted, click Detect Receiver.  

 

6. If Citrix Workspace App for your device is not installed on your PC or Mac, please 

download and install it from https://www.citrix.com/platform/citrix-workspace-

app.html 

 
 

 

 

7. Tick the box beside Always allow sara.cso.ie to open links of this type in the 

associated app, then click Open.  

mailto:rcu@cso.ie
https://www.citrix.com/platform/citrix-workspace-app.html
https://www.citrix.com/platform/citrix-workspace-app.html
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8. Click Desktops. Click on your assigned desktop to launch, then sign in as normal.  

 
 

 

Deleting old 2FA Tokens from your Authenticator App 
 

1. If you have existing CSO tokens (e.g. for “_ext”, “_int” or “_switch” accounts) to log onto 

the Research Data Portal, it is advised that you delete them before adding the new 

token following the launch of ROSA. 

2. On your mobile phone, open the Microsoft Authenticator phone app and click on your 

CSO (e.g. “_ext”, “_int” or “_switch”) account(s), then click Remove Account. 

 

 
 

 

3. On Android = click Remove Account  

On iOS = click Continue  
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4. Follow the instructions in “Setting up 2FA” on page 7 of this document to add the two-

factor authentication token to your new mobile phone. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Useful Tip: 

You might find that when you open ROSA, the page doesn’t display in the 

same way as shown in the screenshots in this document. By holding down the 

{Ctrl} key on your computer and rotating the mouse-wheel forward or back 

you can zoom the page until it displays the information fully. 

mailto:rcu@cso.ie
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RMF Contacts – How to Create a Researcher 

1. The RMF Contact is the point of contact for the Research Organisation 

for researchers from that organisation who want to register for access to 

RMFs. 

To do this, the RMF Contact must log on via https://sara.cso.ie to the RDP 

Desktop and open ROSA from the Windows desktop. ROSA will open to 

the Organisation page. 

 

2. The RMF Contact must press the “Organisation Researchers” tab to 

display all the researchers from their organisation, and then press “Create 

Researcher” in the top-right of the page. 

 

mailto:rcu@cso.ie
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3. This will open the “Create Researchers” form. 

 

4. Please complete the form on behalf of the researcher requesting access. 

The RMF Contact must enter an organisation email address. Personal 

email addresses are not allowed, and such applications will be declined. 

Please enter the researcher’s mobile telephone number only as this will 

be used to send the researcher their password via SMS. Only mobile 

telephone numbers provided by an Irish operator are allowed. 

The Comment section can be used to help one identify the Researcher by 

way of their office or building location, their team, or role, etc, should this 

be necessary when their project applications come in. When the form is 

complete, press “Create”. 
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5. When the Researcher profile is created, the researcher will receive an 

email with a new username and instructions on how to log on to the 

Research Data Portal (RDP). They will complete their Researcher 

Registration within ROSA.  

 

 

 

 

 
 

RMF Contacts – How to Approve an Application 

1. The RMF Contact is a person designated by the Research Organisation’s 

Senior Representative to provide approval for applications on behalf of 

their organisation before it is forwarded to the CSO. 

The RMF Contact has visibility of all researcher profiles and project 

records relating to their own organisation within ROSA, with the exception 

of project outputs. Also, they cannot see project folders or their contents. 

Should the RMF Contact wish to also be a Researcher, they must contact 

RCU directly to request this role-change. They will then have to complete 

Useful Tip: 

You might find that when you open ROSA, the page doesn’t display in the 

same way as shown in the screenshots in this document. By holding down the 

{Ctrl} key on your computer and rotating the mouse-wheel forward or back 

you can zoom the page until it displays the information fully. 

mailto:rcu@cso.ie
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the Researcher Registration Application Form and be approved by the 

CSO. 

When the RMF Contact opens ROSA from the RDP Desktop, they may 

click on “Tasks” from the top menu-bar. 
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2. The RMF Contact may see a number of tasks in their Task List. These 

may be Researcher Registration Applications or Project Applications. 

They can sort any of the columns according to their preferred criteria to 

locate the application. 

Once they have located the application that they wish to consider, they 

must press “View” on the right-hand side to view further details. 

 

 

3. The RMF Contact must view each page in the application, navigating 

using the tabs on the left-hand side. Only when all the pages within the 

application have been viewed can the RMF Contact approve, return or 

reject the application.  
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4. To record a decision against the application, the RMF Contact must press 

the Burger Menu, or plus sign, in the bottom right corner of ROSA. 

 

 

5. To approve the application, they must press Approve. This will open a new 

textbox in which the RMF Contact must add a comment expressing their 

support for the application and any observations that they may have. 
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6. If the RMF Contact identifies an error in the application, or seeks further 

clarification, they may select to return the application to the Lead 

Researcher. 

 

 

7. The RMF Contact may also reject an application to prevent it from 

proceeding for consideration by the CSO.  
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The RMF Researcher Role 
 

If you are an existing RMF Contact and wish to become registered as a 

Researcher, you must contact RCU at rcu@cso.ie. Your role will be changed to 

“RMF Researcher”. 

 

If you are an existing Researcher and are required by your organisation to 

become an RMF Contact, either the Senior Representative or an existing RMF 

Contact must send that request via email to rcu@cso.ie. 

 

Once approved, your role within ROSA will be changed to “RMF Researcher”, 

essentially a hybrid of “RMF Contact” and “Researcher”.  

 

This means that you can view the ROSA project records of all projects within 

your organisation, not just the projects to which you are assigned. This is what 

is visible within the “Projects” tab. You cannot make projects “live” here. 

 

When you click on the “First Name Surname” tab, you will then see the “My 

Projects” tab on the left-hand menu. It is within this project list that you can 

make a project to which you have been assigned “live”. 
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Researchers - Completing your Researcher Profile 

1. New researchers must ask their RMF Contact to create a researcher 

account for them within ROSA. Once it is created, ROSA will immediately 

send the researcher an email providing them with a username and 

instructions on how to log in to the system. 

 

 

2. On your first logon, you will have to launch ROSA from the Research Data 

Portal (RDP) Desktop and verify your details. You will also have to provide 

your work and home addresses. 

In the Consent section you will declare whether you allow your name to 

be visible to other researchers. Should you consent, your name will 

become visible to researchers from other organisations so that they may 

add you to their research project(s). 

Please save each page as you complete it. 

mailto:rcu@cso.ie
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Researcher Registration

• On your first logon, you will have to

launch ROSA from the Research Data

Portal (RDP) Desktop and verify your

details. You will also have to provide

your work and home addresses.

• In the Consent section you will declare

whether you allow your name to be

visible to other researchers.

• Please save each page as you

complete it.

 

3. On the Research Experience page of your profile, please answer the 

questions relating to statistical experience.  

Researcher Registration

• On the Research Experience page

of your profile, please answer the

questions relating to statistical

experience.

• In the “Statistical Disclosure

Control” section, acknowledge your

consent to follow our SDC

guidelines.

 

 

4. Under “My Publications” select  
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5. Enter the relevant details as can be seen in the Publication box below, 
and select “+Create” 

  

 
  

  

If the Researcher does not yet have a qualifying publication / journal to 
enter. ROSA will not allow them to save the Researchers Profile without 
this entry.   
  
The Researcher should enter "Not Applicable" in the Publication Title field 
and use today's date for the "Publication Date".  
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6. In the “Statistical Disclosure Control” section, acknowledge your consent 

to follow our SDC guidelines.  

 

 

7. In the Security tab, you are asked to declare that you will apply security 

rules and practices to ensure that CSO RMF data is safe from 

unauthorised access.  

Your agreement is required before you can proceed. 

Researcher Registration

• In the The Security tab, you are

asked to declare that you will apply

security rules and practices to

ensure that CSO RMF data is safe

from unauthorised access.

• Your agreement is required before

you can proceed.
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8. The Training section within ROSA replaces previous RMF training 

provided by the CSO.  

The training is divided into five mandatory video modules that you can 

watch in your own time.  

There are multiple-choice questions associated with the first three 

modules. All modules of the training must be successfully completed 

before access can be granted to your RMF projects.  

As a migrated Researcher, once you have completed and saved all pages 

of the Researcher Registration Form within ROSA, you will be able to 

access your projects. 

New Researchers must press the “Submit” button to progress their 

Researcher Registration application. This will have to be approved by 

their organisation’s RMF Contact, as well as by the CSO. 

Researcher Registration

• The Training section within ROSA
replaces previous RMF training
provided by the CSO.

• The training is divided into five
mandatory video modules that you can
watch in your own time.

• There are multiple-choice questions
associated with the first three modules.
All modules of the training must be
successfully completed before access
can be granted to your RMF projects.
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Researchers – Creating a New RMF Project Application Within ROSA 

1. Once you are registered with the CSO as a researcher, you can create, or 

be added to, an RMF project application.  

To create an RMF project within ROSA, select “Create Project” from the 

“My Projects” page. 

Applying for an RMF Project

• Once you are registered with the

CSO as a researcher, you can

create, or be added to, an RMF

project application.

• To create an RMF project within

ROSA, select “Create Project”

from the “My Projects” page.

 

 

2. Complete each page of the RMF project application form by using each 

of the tabs on the left-hand side of ROSA.  

• Complete each page of the RMF

project application form by using

each of the tabs on the left hand

side of ROSA.

Applying for an RMF Project

 

 

mailto:rcu@cso.ie


 

29 
Email: rcu@cso.ie  

3. On the Project Details page, please provide: 

• the project name  

• the project folder name  

• the summary of the project (This should be a concise but accurate 

synopsis of the project. This wording will be used within the Officer 

of Statistics Certificate).  

You can provide greater detail regarding the project within the “Project 

Details” textbox (including background, methodologies used, etc). 

Applying for an RMF Project

On the Project Details page, please provide:

• the project name

• the project folder name

• the summary of the project

• This should be a concise but accurate
synopsis of the project. This wording will be
used within the Officer of Statistics Certificate.

• You can provide greater detail regarding 
the project within the “Project Details” 
text-box (including background, 
methodologies used, etc).

 

4. There are switches to confirm your answers to a number of questions 

(click on them to toggle yes/no). You will also have to outline your 

understanding of Statistical Disclosure Control.  

Applying for an RMF Project

• There are switches to confirm your 

answers to a number of questions 

(click on them to toggle yes/no).

• You will also have to outline your 

understanding of Statistical 

Disclosure Control.
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5. Additional questions may appear immediately beneath answers  

that are toggled to yes, requesting further clarification. 

 

Applying for an RMF Project

• Additional questions may appear 

immediately beneath answers that 

are toggled to yes, requesting 

further clarification. 

 

 

 

6. Provide the additional details required in these nested fields. 

Applying for an RMF Project

• Additional questions may appear 

immediately beneath answers that 

are toggled to yes, requesting 

further clarification. 
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7. Once the Project Details page is complete: 

Click on the Plus sign in the bottom right corner and select “Save 

Changes.”  

Applying for an RMF Project

Once you have completed the Project

Details page:

• Click on the Plus sign in the

bottom right corner and select

“Save Changes.”

 

 

8. When you save your changes, you will see a pop-up box that says 

“Success.” 

Now you can move on to the Researcher Management page from the 

menu on the left-hand side. 

Applying for an RMF Project

• When you save your changes, you

will see a pop up box that says

“Success.”

• Now you can move on to the

Researcher Management page

from the menu on the left-hand

side.
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9. To add another registered researcher to your project: 

Press the “Add Researcher” button and search for the researcher from 

the list. 

Applying for an RMF Project

To add another registered researcher to your
project:

• Press the “Add Researcher” button and search
for the researcher from the list.

• Please note that it is possible to select and
add any registered researcher who appears on
this list. All researchers from other
organisations on this list will have consented
to sharing their name.

• If a registered researcher’s name is not
showing on the list, it may mean that they
have not consented to sharing their name with
researchers from outside their organisation.

 

 

10. Please note that it is possible to select and add any registered researcher 

who appears on this list. All researchers from other organisations on this 

list will have consented to sharing their name. 

If a registered researcher’s name is not showing on the list, it may mean 

that they have not consented to sharing their name with researchers from 

outside their organisation. 

Applying for an RMF Project

To add another registered researcher to your
project:

• Press the “Add Researcher” button and search
for the researcher from the list.

• Please note that it is possible to select and
add any registered researcher who appears on
this list. All researchers from other
organisations on this list will have consented
to sharing their name.

• If a registered researcher’s name is not
showing on the list, it may mean that they
have not consented to sharing their name with
researchers from outside their organisation.
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11. Once you have added the additional researcher to your project, a 

message will appear to show that the researcher was added. 

Applying for an RMF Project

To add another registered researcher to your
project:

• Press the “Add Researcher” button and search
for the researcher from the list.

• Please note that it is possible to select and
add any registered researcher who appears on
this list. All researchers from other
organisations on this list will have consented
to sharing their name.

• If a registered researcher’s name is not
showing on the list, it may mean that they
have not consented to sharing their name with
researchers from outside their organisation.

 

 

12. Once all the desired researchers have been added to your project, press 

“Confirm Researchers”.  

Applying for an RMF Project

To add another registered researcher to your
project:

• Press the “Add Researcher” button and search
for the researcher from the list.

• Please note that it is possible to select and
add any registered researcher who appears on
this list. All researchers from other
organisations on this list will have consented
to sharing their name.

• If a registered researcher’s name is not
showing on the list, it may mean that they
have not consented to sharing their name with
researchers from outside their organisation.
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13. A “Success” message will appear. 

Applying for an RMF Project

To add another registered researcher to your
project:

• Press the “Add Researcher” button and search
for the researcher from the list.

• Please note that it is possible to select and
add any registered researcher who appears on
this list. All researchers from other
organisations on this list will have consented
to sharing their name.

• If a registered researcher’s name is not
showing on the list, it may mean that they
have not consented to sharing their name with
researchers from outside their organisation.

 

 

14. Next, select “Dataset Management” from the left-hand menu: 

Applying for an RMF Project

Next, select “Dataset Management”

from the left-hand menu:

• Press the Add Dataset button and

then select the dataset(s) that are

required for the project.

• Details regarding each RMF can

be accessed in the “RMF Register”

on the CSO website.
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15. Press the Add Dataset button and then select the dataset(s) that are 

required for the project. 

Details regarding each RMF can be accessed in the “RMF Register” on 

the CSO website. 

Applying for an RMF Project

Next, select “Dataset Management”

from the left-hand menu:

• Press the Add Dataset button and

then select the dataset(s) that are

required for the project.

• Details regarding each RMF can

be accessed in the “RMF Register”

on the CSO website.

 

 

16. RMFs are grouped by Category and then RMF Name. RMFs are divided 

between Business Statistics, Social and Demographic, COVID-19 and 

Administrative Data.  

Applying for an RMF Project

Next, select “Dataset Management”

from the left-hand menu:

• Press the Add Dataset button and

then select the dataset(s) that are

required for the project.

• Details regarding each RMF can

be accessed in the “RMF Register”

on the CSO website.
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17. Once you have chosen the RMF, you can select individual datasets by 

clicking on each row. 

Applying for an RMF Project

Next, select “Dataset Management”

from the left-hand menu:

• Press the Add Dataset button and

then select the dataset(s) that are

required for the project.

• Details regarding each RMF can

be accessed in the “RMF Register”

on the CSO website.

 

 

18. Alternatively, you can toggle the “Select All Datasets” between “Yes” and 

“No” to select all or none of the displayed datasets. 

Applying for an RMF Project

Next, select “Dataset Management”

from the left-hand menu:

• Press the Add Dataset button and

then select the dataset(s) that are

required for the project.

• Details regarding each RMF can

be accessed in the “RMF Register”

on the CSO website.
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19. Confirm your selection by pressing the “Add Dataset to the Project” 

button in the bottom-right corner.  

Applying for an RMF Project

Next, select “Dataset Management”

from the left-hand menu:

• Press the Add Dataset button and

then select the dataset(s) that are

required for the project.

• Details regarding each RMF can

be accessed in the “RMF Register”

on the CSO website.

 

 

20. If you want future releases, or instances, of an RMF to be delivered to your 

project folder as they are released during the course of your project, you 

must explicitly request it. To do so, once you have added your chosen 

datasets to the project, scroll down to the RMF Names section of the 

Datasets page of your project application and, under the “Future 

Instances Requested” column. 
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21. Select “Yes”. A notification will appear to indicate that the datasets’ future 

instance was successfully updated. 

 

 

 

 

22. Click the burger menu in the bottom-right corner and press “Save”.  
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23. It is possible to add multiple datasets from multiple RMFs in this way.  

Applying for an RMF Project

Next, select “Dataset Management”

from the left-hand menu:

• Press the Add Dataset button and

then select the dataset(s) that are

required for the project.

• Details regarding each RMF can

be accessed in the “RMF Register”

on the CSO website.

 

 

24. Provided that all pages of the application have been completed correctly, 

a green banner will appear saying “The RMF Application Form is now 

complete and can be submitted for approval”. 

Press the “Submit for Approval” button. 

 

 

 

Applying for an RMF Project

Once the Researchers and Datasets

have been chosen:

• Press the plus button in the

bottom-right corner and select

save.

• You will then see a pop up that

says “Success”.

• Press OK to continue.
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25. On-screen confirmation of the project submission will display. 

 

 

26. Your organisation’s RMF Contact(s) will automatically receive an email 

requesting that they log onto ROSA to approve the application.  

Once approved, the application will go through the CSO RMF approval 

process until it has been approved by the Director General or has been 

declined at some stage. 

 

 

 

Applying for an RMF Project

• Finally, you will have to review the

application by selecting each page

from the left-hand menu.

• Once satisfied, select the “Submit

for Approval” button.

• On-screen confirmation of the

project submission will display.

Applying for an RMF Project

• Your organisation’s RMF Contact(s) will

receive an email requesting that they log

onto ROSA to approve the application.

• Once approved, the application will go

through the CSO RMF approval process until

it has been approved by the Director

General, or has been declined at some

stage.

mailto:rcu@cso.ie


 

41 
Email: rcu@cso.ie  

Researchers – Accepting the Standard Agreement and Officer of Statistics 
Certificate 

Where the project has been approved by the RMF Contact, and then by the CSO:  

1. All researchers named on the project will be prompted to log in to ROSA. 

Applying for an RM F Project

Where the project has been approved:

• All researchers named on the project w il l be

prompted to log in to ROSA.

• The researchers w il l read and accept the

terms and conditions of the RMF Standard

Agreement, the Officer of Statistics certi ficate

and the Declaration of Secrecy.

• Once the last researcher has accepted the

terms and conditions of the RMF Standard

Agreement and electronically signed the

Officer of Statistics certif icate, the project w il l

be available w ithin the RDP.

 

2. The researchers will now open the Documents tab, which is accessed 

under your Profile, select "My Projects" and select view on the relevant 

project, Documentation is on the left-hand side. Read and accept the 

terms and conditions of the RMF Standard Agreement, the Officer of 

Statistics certificate and the Declaration of Secrecy. 

 

Applying for an RM F Project

Where the project has been approved:

• All researchers named on the project w il l be

prompted to log in to ROSA.

• The researchers w il l read and accept the

terms and conditions of the RMF Standard

Agreement, the Officer of Statistics certi ficate

and the Declaration of Secrecy.

• Once the last researcher has accepted the

terms and conditions of the RMF Standard

Agreement and electronically signed the

Officer of Statistics certif icate, the project w il l

be available w ithin the RDP.
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3. Once the last researcher has accepted the terms and conditions of the 

RMF Standard Agreement and electronically signed the Officer of 

Statistics certificate, the project will be available within the RDP. 

Applying for an RM F Project

Where the project has been approved:

• All researchers named on the project w il l be

prompted to log in to ROSA.

• The researchers w il l read and accept the

terms and conditions of the RMF Standard

Agreement, the Officer of Statistics certi ficate

and the Declaration of Secrecy.

• Once the last researcher has accepted the

terms and conditions of the RMF Standard

Agreement and electronically signed the

Officer of Statistics certif icate, the project w il l

be available w ithin the RDP.

 

 

4. Once you have been notified that the project is active, you will be able to 

select that project and make it “Live” from your Project List within ROSA. 

Working with an RM F Project

• Once you have been notified that the

project is active, you w ill be able to

select that project and make it “Live”

from your Project List w ithin ROSA.

Toggle the active project sl ider to do

this.

• Perm issions w ill be automatically

assigned to your chosen project folder.

You w ill be able to view the project

folder and to create, modify and delete

fi les and subfolders w ithin it.

• The RMF datasets to w hich access w as

approved w ill be in the “Inputs”

subfolder.

 

 

 

Researchers – Making a Project Folder Accessible Within ROSA 
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1. All of your project records will be available to view within the “My 

Projects” tab under your profile. 

 

You can view the details of each project by selecting “View”. 

Working with Projects within ROSA

• All of your projects will be available
to view within the “My Projects” tab
under your profile.

• You can view the details of that
project by selecting “View”.

• To access the project folder within
File Explorer, you must make your
chosen project “live” by toggling the
Yes/No switch in the “Project Live”
column.

 
 

2. Select the project that you wish to work on. To make the project folder 

available to you within File Explorer, change the value of that project 

under the “Project Live” column to “Yes”. You can only have one project 

“live” at any one time. This ensures that only one project folder is visible 

within File Explorer at any given time. 

Working with Projects within ROSA

• All of your projects will be available
to view within the “My Projects” tab
under your profile.

• You can view the details of that
project by selecting “View”.

• To access the project folder within
File Explorer, you must make your
chosen project “live” by toggling the
Yes/No switch in the “Project Live”
column.
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You must then log out of the Researchers Data Portal desktop and log 

back in for permissions will be automatically assigned to your chosen 

project folder within File Explorer. You will now be able to see and open 

the project folder within your mapped drive on File Explorer and to create, 

modify and delete files and subfolders within it. 

Every project folder has the same folder structure: 

There is an “Input” folder which will contain any RMF dataset(s) that 

has/have been made available to your project. Only the datasets that 

have been requested in your project application will be copied to your 

Input folder. You will find codebooks, the Boston College repository of 

STATA code and other resources by opening the “Supporting 

Documentation” shortcut from your Input folder. 

The “Researchers” folder is where you will save all of your working files. 

This folder is a shared collaborative workspace where you and all the 

researchers assigned to the one project will have full (write/read/modify) 

permissions to every file and subfolder within. You will also be able to 

create folders for individual researchers on the project here. 

The “Researchers” folder is the only location where you can save your 

files. You cannot save files to the Desktop, My Documents folder or any 

Working with an RMF Project

• Once you have been notified that the

project is active, you will be able to select

that project and make it “Live” from your

Project List within ROSA. Toggle the

active project slider to do this.

• Permissions will be automatically

assigned to your chosen project folder.

You will be able to view the project folder

and to create, modify and delete files and

subfolders within it.

• The RMF datasets to which access was

approved will be in the “Inputs” subfolder.
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other location other than the folders within your project folder. You 

cannot move files from one project folder to another. 

 

 

To sign out correctly, press the Windows icon in the bottom-left corner of 

the Research Data Portal desktop to display the Start Menu. Then click 

the user profile icon at the top of the menu and press “Sign Out”. The 

desktop will close, and you will have to launch the Research Data Portal 

desktop again from Citrix Storefront. The project you selected will now 

be available in File Explorer. 
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Researchers – Renewing an Active Research Project  

1. The Lead Researcher will be sent a reminder notification by email two 

months prior to the expiration date of your project. 

If the Lead Researcher wishes to apply to renew the project, they must, 

from their Project List within ROSA, press the project’s “Renew” button on 

the right-hand side.  

 

 

2. A reason for the renewal application must be provided. 

 

RMF Project Expiry

• The Lead Researcher will be sent a reminder

notification by email two months prior to the

expiration date of your project.

• If the Lead Researcher wishes to apply to renew the

project, they must, from their Project List within

ROSA, press the project’s “Renew” button on the

right-hand side.

• A reason for the renewal application must be

provided.

RMF Project Expiry

• The Lead Researcher will be sent a reminder

notification by email two months prior to the

expiration date of your project.

• If the Lead Researcher wishes to apply to renew the

project, they must, from their Project List within

ROSA, press the project’s “Renew” button on the

right-hand side.

• A reason for the renewal application must be

provided.
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Researchers – Requesting the Release of Output Files 

1. When you have created a file within the RDP that you wish to be released: 

Browse to the Outputs tab, then press the “Add File Output to the Project” 

button.  

 

2. Once you have provided a reason for the output request and confirmed 

SDC details, you can drag and drop the required files into the “Upload File 

Outputs” frame and click “Submit”. 

Where the request is approved by the Data Custodian, the files will be 

emailed to you directly. 

 

Releasing Outputs

When you have created a file within the

RDP that you wish to be released:

• Browse to the Outputs tab, then press the “Add File

Output to the Project” button.

• Once you have provided a reason for the output

request and confirmed SDC details, you can drag and

drop the required files into the “Upload File Outputs”

frame and click “Submit”.

• Where the request is approved by the Data

Custodian, the files will be emailed to you directly.

Releasing Outputs

When you have created a file within the

RDP that you wish to be released:

• Browse to the Outputs tab, then press the “Add File

Output to the Project” button.

• Once you have provided a reason for the output

request and confirmed SDC details, you can drag and

drop the required files into the “Upload File Outputs”

frame and click “Submit”.

• Where the request is approved by the Data

Custodian, the files will be emailed to you directly.
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Working with Statistical packages 
 

In order to protect your data and that of the CSO, our RDP environment is isolated from the 

internet. It is not possible to access any online resources from within the virtual desktop. 

As the usefulness of Stata or R-Studio depends greatly on the installation of additional 

external packages, RCU maintain an offline repository of packages for both applications.  

 

Importing Packages to R-Studio 
 

A full repository of packages (CRAN) is available from a regularly updated mirror of CRAN 
located on:  

\\crctx-CRAN\CRAN2\bin\windows\contrib\ 

In order to access and install from this mirror, please follow the below instructions:  
 
· Open R-Studio  
· Click on Tools->Global Options... 
· Click Packages 
· Untick - Use secure download method for HTTP 
· Click Apply 
· Click Ok 

Enter the following lines to install packages including dependencies:  

options(repos=NULL)  

(install.packages("package_name", contriburl = "file:////crctx-
/CRAN2/bin/windows/contrib/4.1"))  

For example, in order to install the gglot2 package, use:  

(install.packages("ggplot2", contriburl = "file:////CRCTX-
CRAN/CRAN2/bin/windows/contrib/4.1")) 

It is possible to install multiple packages simultaneously by adding their names to the above 
command, separated by a comma, e.g. 

(install.packages(c(“reshape2”, “foreign”, “scales”, “plyr”, “gdata”, “xtable”, “zoo”,”seasonal”), 
contriburl = "file:////crctx-cran/CRAN2/bin/windows/contrib/4.1")) 

Please note: Installation of packages in RStudio via Tools-> Install Packages... will not 
function and should only be attempted via the install.packages command, documented 
above. 
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Importing Packages to Stata 
 

The Boston College code repository, “BoCoDe”, is a comprehensive collection of user-written 

packages for Stata. RCU synchronises the offline BoCoDe repository with Boston College 

periodically throughout the year. 

To access these code packages within Stata, click on “File | Open” and browse to the project 

shortcut within your home-drive. Then open the “Input | Syntax” folder and double-click on the 

“bocode” shortcut. Packages are grouped into folders alphabetically. For a full definition of 

the function of each package, please refer to https://ideas.repec.org/s/boc/bocode.html 

 

Importing CSV Format Datasets 
 

In parallel to the development of ROSA, the Data Hub team was established and a new 

procedure was created to centralise all CSO datasets using Hadoop. As it is configured, the 

datasets are delivered from Hadoop to project folders in .CSV file format only for all RMF 

types. The benefits of Hadoop and how the datasets are delivered allows for automated 

distribution, updating and version control of datasets. There is no ability, unfortunately, to 

distribute datasets in .SAV, .SPS or any other file-format other than .CSV. 

 

Importing CSV Datasets into STATA 

A CSV file is really just a text file, but structured so that each line of text represents one 
observation and each variable is separated by a comma. Hence the name, comma-separated 
variable file. Text files that put a specific character between variables are also known as 
delimited files, and the Stata command to read them is import delimited. 

capture log close 

log using imp_csv.log, replace 

 

clear all 

set more off 

 

import delimited using gss2014 

 

save gss2014_from_csv, replace 

 

log close 

The import delimited command will try to figure out whether the first row contains 

variable names or data, and usually succeeds. If it gets it wrong, you can specify that the first 
row contains variable names with the varnames(1) option. 

Importing an Excel spreadsheet or CSV file takes longer than loading a Stata data set, and 
there's no need to repeat that process every time you analyze the data. That's why these do 
files simply import a data set and save it as a Stata data set. You can then write a separate do 
file that loads the Stata data set and carries out your analysis. 
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Importing CSV Datasets into SPSS 

 

SPSS can import data from a CSV or any other text based file using the  "File"->"Read Text 
Data..." option. This will open a pop-up dialogue which allows the user to select the CSV file 
from the hard drive. Once the file has been selected, the "Text Import Wizard" will start. The 
import process consists of six steps that can be cycled through using the "Back" and "Next" 
buttons at the bottom of the wizard.   

 

Step 1: 

SPSS allows the user to save the settings used to import files, and so this step is asking 
whether settings for this file have already been saved of this computer. In this case they 
haven't, so mark "No." 
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Step 2: 

In the second step, mark "Delimited" under "How are your variables arranged?" This tells SPSS 
that the data is formatted in units divided by specific characters. Then check "Yes" under "Are 
variable names included at the top of your file?," which specifies that the first line of the file 
contains the column headers for the table that holds the data. Columns in SPSS are frequently 
referred to as variables. 
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Step 3: 

This step controls which parts of the file will be pulled into SPSS. Since SPSS knows that the 
column names are on the first line, the first case will automatically be set to "2." Each line 
represents a case, and we will want to import all lines. 
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Step 4: 

Under "Which delimiters appear between variables?" check "Comma" and "Space." "Delimiters" 
are the characters that separate each data value. Check "Double Quote" as the text qualifier, 
which is the character used to distinguish a single value. (This resolves any ambiguity arising 
form values that contain commas). 
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Step 5: 

Step 5 allows changes to be made to any of the variable data. You won't need to make any 
changes for this dataset, but in many instances data sets will not have preimported variable 
names, or SPSS may not automatically recognize the correct "Data format." The SPSS Data 
format format of a variable controls what type of value it contains: numbers are numeric and 
characters are strings. Other types are also possible, like "Date," "Dollar," and "Scientific 
notation." 

mailto:rcu@cso.ie


 

55 
Email: rcu@cso.ie  

 

Step 6: 

The final step allows the user to save the import configuration by checking "Yes" under "Would 
you like to save this file format for future use?" The "Would you like to paste the Syntax?" 
option will print the command syntax to the output viewer. The "Cache Data Locally" option 
makes a copy of the data in memory to improve performance. Depending on your computers 
memory you may need to uncheck this for files larger that one or two gigabytes. 
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Importing CSV Datasets into R or R-Studio 
 

Suppose I have a CSV file called data.csv saved in the following location: 

C:\Users\Bob\Desktop\data.csv 

And suppose the CSV file contains the following data: 

team, points, assists 
'A', 78, 12 
'B', 85, 20 
'C', 93, 23 
'D', 90, 8 
'E', 91, 14 

There are three common ways to import this CSV file into R: 

1. Use read.csv from base R (Slowest method, but works fine for smaller datasets) 

data1 <- read.csv("C:\\Users\\Bob\\Desktop\\data.csv", header=TRUE, 
stringsAsFactors=FALSE) 

2. Use read_csv from readr package (2-3x faster than read.csv) 

library(readr) 
 
data2 <- read_csv("C:\\Users\\Bob\\Desktop\\data.csv") 

3. Use fread from data.table package (2-3x faster than read_csv) 

library(data.table) 
 
data3 <- fread("C:\\Users\\Bob\\Desktop\\data.csv") 

This tutorial shows an example of how to use each of these methods to import the CSV file 
into R. 

Method 1: Using read.csv 

If your CSV file is reasonably small, you can just use the read.csv function from Base R to 
import it. 

When using this method, be sure to specify stringsAsFactors=FALSE so that R doesn’t 
convert character or categorical variables into factors. 

The following code shows how to use read.csv to import this CSV file into R: 

#import data 
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data1 <- read.csv("C:\\Users\\Bob\\Desktop\\data.csv", header=TRUE, 
stringsAsFactors=FALSE) 
 
#view structure of data 
str(data1) 
 
'data.frame':   5 obs. of  3 variables: 
 $ team   : chr  "'A'" "'B'" "'C'" "'D'" ... 
 $ points : int  78 85 93 90 91 
 $ assists: int  12 20 23 8 14 

Method 2: Using read_csv 

If you’re working with larger files, you can use the read_csv function from the readr package: 

library(readr) 
 
#import data 
data2 <- read_csv("C:\\Users\\Bob\\Desktop\\data.csv") 
 
#view structure of data 
str(data2) 
 
'data.frame': 5 obs. of 3 variables: 
 $ team : chr "'A'" "'B'" "'C'" "'D'" ... 
 $ points : int 78 85 93 90 91 
 $ assists: int 12 20 23 8 14 

Method 3: Using fread 

If your CSV is extremely large, the fastest way to import it into R is with the fread function from 
the data.table package: 

library(data.table) 
 
#import data 
data3 <- fread("C:\\Users\\Bob\\Desktop\\data.csv") 
 
#view structure of data 
str(data3) 
 
Classes 'data.table' and 'data.frame':  5 obs. of  3 variables: 
 $ team   : chr  "'A'" "'B'" "'C'" "'D'" ... 
 $ points : int  78 85 93 90 91 
 $ assists: int  12 20 23 8 14 

Note that in each example we used double backslashes (\\) in the file path to avoid the 
following common error: 

Error: '\U' used without hex digits in character string starting ""C:\U" 
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